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Creating A Grade Sheet With Microsoft Excel
Microsoft Excel serves as an excellent tool for tracking grades in your course. But its
power is not limited to its ability to organize information in rows and columns. Using
formulas and functions in Excel, you can simplify the grading process. With
Excel you can sort students by names, grades or whatever characteristics you choose.
You can also setup a grade curve in advance and have Excel automatically assign letter
grades (not just percentages) to each of your students. When you change the curve, the
grades will change automatically. This tutorial will show you how to setup a grading
sheet in Excel that makes use of all these functions plus some other helpful features that
will be explained in detail later.
This tutorial assumes the reader has a basic understanding of how to navigate a
spreadsheet and enter data in cells. A reader who is experienced with Excel and is
familiar with entering formulas and the difference between absolute and relative cell
references can begin in section three.
Also, note that this tutorial is based on Excel 2000 for Windows. Everything in this
tutorial with the exception of keyboard shortcuts will work in Excel for Mac.
1) Introductory Excel: Entering Formulas
In Excel, formulas allow a user to make new calculations based on data entered into a
spreadsheet. In simple terms a formula is made up of a combination of numbers, cell
references and mathematical operators. To input a formula, click once on the cell in
which you wish to enter a formula. Then click on the formula bar to begin entering your
formula.
In Figures 1.1 and 1.2 we have entered the number 1 in cell A1 and the number 2 in cell
B2. We will add a formula into cell C3 to calculate the sum of cells A1 and B2. Note
that after clicking on cell C3 we type the formula in the formula bar just above the
worksheet. Once the formula is complete, hit enter. Cell C3 now displays the result of
your formula, the value 3. In other words A1+B1 = 3 because 1+2=3. Whenever you
enter a formula into a cell, the cell will always display the result of the formula and not
the formula itself. However, if there is a formula in the cell, it will be displayed in the
formula bar.
Figure 1.1
Enter your formula in
the formula bar. All
formulas must begin
with the equal sign.
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Figure 1.2

Our formula has been
entered in the formula
bar. Note that while the
formula itself shows in
the formula bar, the
result of the formula (3)
shows in the cell.

When entering formulas for your grade sheet, most likely you will use the typical
mathematical operators to calculate your grade formulas. They include the following:
Addition
Subtraction
Multiplication
Division

+
*
/

The order of calculation follows conventional mathematics. You can use parentheses to
organize your formulas, but be aware that Excel calculates from the inside out where
there are multiple sets of parentheses. For example, Excel calculates the formula
=((2+3)*5) in the following way:
2+3 = 5
then
5 * 5 = 25
So the answer to the formula =((2+3)*5) is 25. Note that you always must have
matching pairs of parentheses. If Excel finds they do not match it will give you an error
message like that in Figure 1.3. The error message in Figure 1.3 appeared as the result
of the formula =((2+3)*5. The correct version would be =((2+3)*5). Of course you
could always mix cell references with numbers in your formulas. The formula
=((A2+3)*5) would also equal 25.
Figure 1.3
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Finally, note that capital letters were used in the formula in Figure 1.2. It is not
necessary to use capital letters. Excel doesn’t care whether you use capitals or lower case
letters when referencing cells. You may want to use lower case letters simply because it
means less typing (less use of the shift key).
2 Introductory Excel: Absolute and Relative Cell References
One of the keys to building a working grade sheet is to understand the difference between
absolute and relative cell references. With the ability to copy and paste cells (and thus
formulas) in Excel spreadsheets, the difference between absolute and relative references
is the difference between a right and wrong answer to your formula. This is critical when
calculating student grades because a wrong formula may lead to you reporting the wrong
grade for a student.
2.1 Relative Cell References
In a formula in which you use relative cell references, the cell references will change
depending on where you copy the original in your spreadsheet. The best way to
understand this is through an example.
In Figure 2.1 data has been entered in three rows and two columns. Your goal is to add
the values across columns so that you have a result in the third column. In Figure 2.1,
cell A1 will be added to cell B1 and the result will be placed in C1. A2 and B2 will be
added with the result in C2, and A3 and B3 will be added with the result showing in C3.
To begin, enter your formula in C1. Once the formula has been entered you can simply
copy it into cells C2 and C3. This is displayed in Figure 2.2.

Figure 2.1

Figure 2.2
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If you look over Figure 2.2 carefully, you will notice that the formula entered in cell C3
is different from that in cell C1. When you copied cell C1 to C2 and C3 the cell
references automatically changed. This is because the cell references are in relative
reference form. What this means is that the formula in cell C1 adds a cell two spaces to
the left with a cell one space to the left. When you copy this formula to C3, two spaces to
the left is A3 and 1 space to the left is B3. Thus, where relative cell references are used,
the cells that enter into the formula depend on the location in the spreadsheet of the
formula itself. When you use an absolute cell reference, your formula will always
reference exactly the same cell or cells no matter where you copy and paste your formula
in your spreadsheet. We turn to absolute cell references next.
2.2 Absolute Cell References
Again, when you use absolute cell references in your formula, your formula will always
point to exactly the same cell or cells no matter where you copy and past your formula in
your spreadsheet. An absolute cell reference looks a bit different from the relative cell
references used above. They have the added feature of a dollar sign $ placed in front of
the row and column references. Thus, if you wanted to add cells A1 and B1 using an
absolute reference, your formula would be =$A$1+$B$1. This is shown in Figure 2.3.
When you copy this formula to cells C2 and C3 (as you did when using relative
references) you will notice that the cell references in your formula do not change. They
still reference A1 and B1. Thus, C2 and C3 will still display the value 15 that is the result
of adding together A1 and B1. This is displayed in Figure 2.4.

Figure 2.3
Using absolute cell references
insures that your formula always
references cells A1 and B1 no
matter where in the spreadsheet
you copy and paste the formula.
Note that your result in C1 is the
same as when you use relative
references.
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Figure 2.4
Even though you copied the formula
down, because of the absolute
references the formulas still
reference cells A1 and B1.

The values in cells C2 and C3
remain the same because the
formulas always reference A1 and
B1.

With absolute references you can also restrict your formulas to columns only (but allow
rows to change) or restrict your formulas to rows only and allow columns to change.
This can be done by entering the $ in front of only the row or only the column reference.
Thus, if you enter the formula =$A1 in a cell and then copy it to different cells in the
spreadsheet, the row number may change, but the column letter will always be A.
Likewise, if you enter =A$1 and then copy it to different cells, the column letter may
change, but the row number will always remain the same.
To ease the entering of absolute references, Excel has a feature that will allow you to add
the $ without having to punch it in directly. Punch a cell reference into the formula bar
Windows and then click and hold to highlight the cell reference only. Press the F4 key once. You
Only
will notice that it has added two dollar signs. If you press F4 again, it will only add the $
to the row reference. Press it again and it switches to only adding the $ to the column
reference. One more press of F4 will remove all the dollar signs.
It is a good idea to practice a little with absolute and relative cell references before
continuing on in this tutorial. You will make extensive use of absolute and relative
references when you punch in your grading formula and you will likely get the most out
of this tutorial if you are comfortable with absolute and relative cell references. Simply
punch in the examples supplied in Figures 2.1 -2.4 above. You may wish to enter more
data or more complex formulas. Don’t be afraid to experiment.
Typically Excel will only display one formula at a time in the formula bar. What is
displayed depends upon what cell you have selected from the spreadsheet. This can be
frustrating when you wish to experiment and learn through comparing differences among
formulas. Fortunately, Excel has a feature that will allow you to display all formulas
Windows entered into a spreadsheet at the same time. This function is called the "reveal codes"
Only
function. To employ it, simply hold down the control key Ctrl and press the tilde key ~.
This will reveal all formulas within their cells on your spreadsheet. This is displayed in
Figure 2.5 on the next page. Note that in the case of Figure 2.5, the formulas use
relative references. To return the spreadsheet to normal mode where the cells display the
results of a formula, simply press Ctrl plus ~ again.
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Figure 2.5
The reveal codes function (Ctrl + ~ ) will
cause Excel to display all formulas within
their respective cells. Another press of
Ctrl +~ returns the spreadsheet to normal.
Note here that we used relative cell
references in our formulas.

3 Setting Up Your Grade Sheet
Having reviewed formulas, absolute and relative cell references, you can now begin
creating a grade sheet. Your grade sheet will have three major components. First, it will
contain a table that lists all the assignments, tests, and activities that will receive a grade,
their individual point values, and the overall weight in percentage terms of each item in
the final grade for the course. Second, it will contain a table that outlines the initial
grading curve for the course (don’t worry too much about this now, you can change the
curve later if you want). Third, it will contain a table that lists all the students in the
course, their scores on individual assignments, and empty spaces for calculating final
course percentages and grades.
3.1 Input A Table Of Assignments
Your first step will be to enter the assignments, their points and overall weights (in
decimal format) into your grade sheet. Start with a blank worksheet. Figure 3.1 displays
your assignment table. Note that your weights should be entered as decimal values. That
is, 10% is entered as .10.
Figure 3.1

Note that we have entered
our weights as decimal
points. Thus, 10% is
entered as .10, 15% is
entered as .15, and so on.

In
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Also, note that even though we gave Quiz 1 a weight of 10% (or .10) we do not have to
grade on a basis of 10 points. You can assign whatever point value we want to each
assignment. Using a weighting scheme (to be explained later) will insure that the Quiz 1
score is properly incorporated in the final grade. Further, this means that you can set up
your point schemes in a way that allows you to give appropriate feedback to students
(you can distinguish good work from bad using either a very coarse or a fine grained
point system). Finally, check and make sure your weights add up to 1.0.
3.2 Input Your Grade Curve
After you have your table of assignments entered, you can move on to enter the grade
curve in the same worksheet as your assignments table. The grade curve will be used to
calculate the final grades for the course. Be carful here because you need to enter the
grade curve in a very specific format if you want Excel to automatically assign letter
grades at the end of the quarter or semester. For now simply enter the grade curve on a
standard ninety, eighty, seventy, sixty basis. You can change this later if you want.
Your grade curve table should be spread between two columns with percentages in the
left column and letter grades in the right column. The grade curve table must be entered
in the following way. Percentages must be entered in ascending order (when moving
down rows) in the left column. Letter grade categories (entered in the right column) are
marked off by the lowest percentage value within the category. This is displayed in
Figure 3.2 below.
Figure 3.2
Percentages are entered in
the left hand column in
ascending order (when
moving from the second row
th
to the 14 row). The values
entered mark off the lowest
value within a grade category.
For example, 0 represents the
lowest F, .6 represents the
lowest D-, .63 the lowest D,
and so on. The highest value
you need is .97 since there is
no category above an A+.

The grades are entered in
ascending order in the righthand column. The letter
grades should be placed in
the same row as the lowest
percentage value for their
category. For example, the
letter grade F is place next to
0 since 0 is the lowest
percentage in the F category.
The letter grade C is placed
in the same row as the
percentage .73 since .73 is
the lowest percentage in the
C category, and so on for
other categories. Note that
the letter grades are also in
ascending order as you move
down the spreadsheet.
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3.3 Setup Your Reporting Table And Enter Students’ Points
The third step is to set up a reporting table (still, in the same worksheet). You will use
this table to enter students names and ID numbers, their point scores on different
assignments, tests, and activities, and set aside space for calculating final percentages and
letter grades. This is displayed in Figure 3.3.
Figure 3.3

3.4 Enter The Formula For Overall Percentage Score
Entering the formula to calculate students’ grades in percentage terms is perhaps the most
difficult part of this project since it requires a lot of typing and an understanding of
weights. Fortunately, if you enter the formula correctly using absolute and relative cell
references, you will only need to type it in once. Then you can simply copy it down the
spreadsheet for all students listed.
Your grading formula will use a weighting scheme that works in the following way. For
each assignment, you will calculate the percentage score for the individual assignment.
You will then multiply this result by the overall weight of the assignment in the final
course grade. The results for all assignments will then be added together to produce the
final percentage score for the overall course. For example, from Figures 3.1 and 3.3 (our
table of assignments and reporting table) you know that Quiz 1 is worth a total of 20
points, and the first student, Ben Jerry, received a 15. You also know that Quiz 1 is 10%
(or .10) of the overall course grade. So, divide 15 by 20 and multiply the result by .10.
Do this calculation for all the activities and assignments completed by Ben Jerry and add
the results together. The full calculation for Ben Jerry is listed below. This equation tells
us that Ben Jerry earned an 80.1% (or .801) for the course overall.
Ben Jerry’s Percentage Score:
=((15/20)*.10) + ((10/20)*.10)+((18/20)*.10)+((35/60)*.15) +((175/200)*.25)+((140/150)*.30)
Quiz 1
Quiz 2
Quiz 3
Midterm
Term Paper
Final

Enter this formula into your spreadsheet in the Percentage column for Ben Jerry.
However, when you enter the formula, instead of using the values as displayed in the
equation above, use cell references. Further, use relative cell references when
referencing those cells that contain a student's score on an activity. Use absolute cell
references when you reference those cells that contain total possible points and the
weights of different assignments. You should use relative references for students scores,
because you will want to copy the formula down the Percentage column for each student
and you will want the scores on the activities to change for each student as you paste the
formula. You should use absolute references for total points and weights because you do
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not want these values to change as you copy and past the formula. You will want these
values to stay the same no matter where you copy and paste your grade calculation
formula. The formula for Ben Jerry is listed below:
=((D19/$B$2)*$C$2)+((E19/$B$3)*$C$3)+((F19/$B$4)*$C$4)+((G19/$B$5)*$C$5)+((H19/$B$6)*$C$6)+
((I19/$B$7)*$C$7)

Phew! That was a lot of careful typing! Check the formula over several times to make
sure it is correct. You may even want to calculate the first student’s score manually just
to make sure the values are correct. Since it is the beginning of the term, you probably
don’t have scores for all assignments and students entered, so just make up some fictitious
data to test your formulas. Once you know the formula works, you can simply copy it
down the page for all students. Again, you might want to check the last student in the list
manually to insure you have correctly entered the absolute and relative cell references.
[Remember, there are two ways you can look at formulas 1) one at a time by simply clicking on a
cell and reading the formula in the formula bar 2) use Ctrl + ~ to reveal all formulas so you can
compare them.]

3.5 Tell Excel How To Assign Letter Grades
Your last step in creating your grade sheet is to enter a formula that will make Excel look
up students percentage score in the grade curve table and then assign a letter grade based
on the percentage score. To do this you will use a built in function called vlookup. This
function is entered in similar form to a formula. It will be entered in the cells labeled
Grade. As with the formula for percentage score listed above, you only need to enter the
vlookup formula once, then you can simply copy it down the spreadsheet for each
student. For Ben Jerry, enter the formula listed below. Explanations of each component
of the formula follows.
=VLOOKUP(I19,$E$2:$F$14,2,TRUE)
=VLOOKUP

This part of the formula tells Excel that you want it to use the VLOOKUP function in the
spread sheet to look up a percentage value and return the associated letter grade. Excel
needs four other pieces of information in the formula to accomplish this task. These
pieces are outlined below. All four pieces must be contained within parentheses and
separated by commas.
I19

This references the cell that contains the value you want Excel to lookup
in the grade curve table. In this case I19 references the cell that contains
the Percentage score for Ben Jerry. This reference is in relative form
because you will want it to change for each student.
$E$2:$F$14

This piece references the complete range of the grade curve table. Excel
identifies the range by the upper left and lower right cells in the range
(when referencing a range the two cell references are always separated by

9

UCLA Office of Instructional Development
Teaching Assistant Training Program

Creating a Grade Sheet With Microsoft Excel

a colon). In our case the upper left cell is E2 and the lower right is F14.
Note that the range does not include the labels, it only includes the values
in the grade curve table. Also, since you are going to be copying the
vlookup formula down the grade sheet, you want to make sure your
vlookup formula always references the same cells in the grade curve table,
so you should use absolute references.
2
The third piece of your formula is the number two. The number 2 tells
Excel from which column it should return values. Excel reads from left to
right so the left column is 1 and the right column is 2. You want Excel to
return letter grades based on the percentage (lookup) values so input 2.
TRUE

When using the vlookup function you can have Excel match specific
values or you have Excel look up approximations. If you enter the value
FALSE, Excel will look for an exact match of the percentage in the grade
table. If it doesn’t find a match it will return #N/A. If you enter the value
TRUE, Excel will look for an approximate match using the percentage
values listed in the grade curve table as category boundaries. If the lookup
value falls within a specific category, Excel will return the grade
associated with that category. Use TRUE, because you do not want to look
for exact matches, instead, you should look at categories.
[Remember, the percentage values in the grade curve table represent the
lowest values for each of the grade categories.]

With the =vlookup formula entered properly, you can simply copy it down the Grade
column so that all students are automatically assigned a letter grade according to what
you have laid out in the grade curve table. If you want to change your curve, you need
only to change the values in the grade curve table, and all letter grades will be adjusted
accordingly. Be aware that if you add another row to your grade curve table (to identify a
finer division among grades) you will need to make the same adjustment in your
=vlookup formula for all students, otherwise their grades will not be reported accurately.
4 Entering Information For Students
With your grade sheet laid out and formulas input, all you have to do now is enter the
point values for each assignment for each individual student. If you have many
assignments and exams for your course, it may become a bit difficult to match a
particular cell with an individual student. The cell may be on the far right hand side of
your screen while the students name is on the far left. The next thing you know you have
fingerprints all over your screen as you try to guide your eye across the row using your
finger. Fortunately, Excel will allow you to split your screen so that the cell in which you
are currently entering data rests right next to the name of your student. This is shown in
Figures 4.1 and 4.2 on the next page.
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Figure 4.1

These are the window “split”
lines. Note they look like a
giant plus symbol.

When you split a window each pane
of the new window can be scrolled
independently of the others using the
scroll bars. Note there are two scroll
bars, one for the left pane and one for
the right pane.

Figure 4.2
Having split the window, you can now
scroll the lower right-hand pane so
that grades match with individual
students. Even with the widow split,
you can still edit data like normal.

4.1 Splitting A Window To Ease Data Entry
To split a window, first you need to figure out where you want the split to appear.
Generally, when you apply the split, the cross point will appear in the upper-left hand
corner of the cell you selected before you applied the split. So, select a cell where you
want the split to appear. Click on that cell once with your cursor so the cell is
highlighted. Select Split from the Window pull-down menu (see Figure 4.3).
Figure 4.3
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To remove the split, simply return to the Window pull-down menu. You should see an
option in the list for Remove Split. Your grade sheet will return to normal once you
click Remove Split (see Figure 4.4).
Figure 4.4

4.2 Sorting Student Scores and Grades
Once you have all your data entered you may wish to see who did well on the first quiz,
or you might want to know how many students received A’s for their final score or you
might want to sort students by their last name so it is easier to record and send grades to
the administration. To sort your students according to some category click and hold your
left mouse button and highlight your entire reporting table including column headings
(such as Quiz 1, Quiz 2, etc.). This is shown in Figure 4.5.
Be careful with sorting. Excel will only sort those columns you have highlighted. If you
only highlight parts of student data, those parts will be sorted independently of other data.
Thus, you will mix up all your student data. The result being you will have to remove it
all and re-enter their scores from scratch.
Figure 4.5

Once you have all the cells in your reporting table highlighted, select Sort from the Data
drop-down menu. A dialogue window named Sort will pop up. From this window, you
can select which column you want to sort by, the order in which you want to sort, and
you can tell Excel whether there is a header row. The header row is simply that row
which identifies the data in your columns. In the example, the header row is row 18
because it contains the column headings (such as First, Last, ID#, Quiz 1, and so on). If
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you do not select the Header option, Excel will treat the columns by their reference
numbers (such as Column A, Column B, and so on). The Sort dialogue box is displayed
in Figure 4.6a and Figure 4.6b. Note from Figure 4.6b you can sort up to 3 columns
together. In Figure 4.6b we have told Excel to sort first by Last (name) then by First
(name), then by Grade. All sorts will be done in ascending order.
Figure 4.6a

Figure 4.6b

5 Auditing Your Spreadsheet: An Alternative Method For Identifying Errors
If you are not sure that you have entered your formulas correctly, Excel offers a feature
that will allow you to check formulas visually rather than by having to read the text of the
formula itself. This feature is called Auditing. When we audit a formula, Excel will use
Lines, Arrows and Dots to show you what other cells (and their respective data) feed into
a cell you select. Conversely, it can also show you what other cells depend upon the data
entered into a cell you select.
To audit your formula, you first must select a cell we want to audit. For the purposes of
this tutorial, you will audit the formula for Percentage in the first row of the reporting
table. You will identify what other cells in the table feed into the Percentage for your
first student in the list. To audit this cell, select the cell by clicking on it once, then select
the Tools pull-down menu. From this menu select Auditing and then Trace Precedents.
This is displayed in Figure 4.7.
With this option selected. You will find that a series of blue arrows and blue dots have
appeared on your spreadsheet. The blue dots identify which cells feed into the cell
(formula) that you selected initially. The arrows connect the blue dots and point at the
cell you selected. If there was an error in your formula you would easily be able to see
that there is a cell feeding into our formula that should not actually be a part of the
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formula. Figure 4.8 shows the arrows and dots feeding into your selected cell. Figure
4.9 shows how you might identify an error in your formula.
Figure 4.7

Note that you could
trace precedents (those
that feed into) to your
selected cell, or you
could trace dependents
(those that depend upon
your cell). To remove
the arrows, you would
simply return to this
menu and select
Remove All Arrows.

Figure 4.8

Note that dots appear in the cells that
feed into your selected cell. Arrows point
to your selected cell. As we might expect
all the cells from your table of
assignments feed into the Percentage.
Also all the students’ scores from the
reporting table feed into the final
Percentage. This suggests that you got
the formula right. You should still check
the text of the formula to be sure.
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Figure 4.9

There is an error in this formula.
Can you figure out what it is?
Ans.: the formula for Quiz 3 is
configured wrong. Koka Kola’s
score on Quiz 3 is being used for
Ben Jerry’s Percentage. We
should correct the error in the
Percentage formula so Ben Jerry
is graded on his own work rather
than Koka Kola’s work.

Clearly, auditing will not tell you exactly what is wrong with your grade sheet, but it can
help quite a lot with locating errors in formulas.
6 Conclusion
We have covered quite a bit of ground in this tutorial. It seems like a lot of work but once
you have your grade sheet set up you will appreciate the power of using a spreadsheet.
Of course, this tutorial says nothing about what sort of grading systems you should use in
the first place. Should you grade on a curve? Should you use an absolute system where
students’ grades depend only on their individual work and not their rank in the class?
What about gap grading? Should grades be the primary form of feedback you give to
students? Should students receive a grade or points for every bit of work they do in a
course? These are some tough questions, which are not easy to answer. To help, here are
some references.
McKeachie, W.J. (1994). Teaching Tips: Strategies, Research, and Theory for College
and University Teachers. Lexington: D.C. Heath and Company.
Pollio, H.R. and W. L. Humphreys (1988). Grading Students. In J.H. McMillan (ed.)
Assessing Students’ Learning. New Directions for Teaching and Learning, 34, pp.85-97
San Francisco: Jossey-Bass.
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